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Abstract — The development of Informatics technology in
electronic media such as cellphones or mobile phones which have
many functions that can facilitate daily human work, commonly
called smartphones, which are growing day by day. The use of
smartphones for elementary school children is now increasing,
because since childhood their parents have accustomed their
children to using smartphones with the Android platform.
Currently, the applications that are widely circulated are
dominated by applications intended for adults, while applications
that are useful and specifically intended for elementary schools are
still relatively few, and educational materials are still limited. By
taking advantage of the many users who use the Android platform
today among elementary school children, research is carried out to
aim to try to make applications that can make it easier for children
to learn about the eye nervous system in humans in this case
making interactive learning applications. The research method
used is the Multimedia Development Life Cycle (MDLC) which has
six stages, namely concept, design, material collecting, assembly,
testing and distribution.

Key words - Eyes; Learning App; Elementary school;
Android; Multimedia Development Cycle;

Abstrak — Perkembangan teknologi Informatika dalam
media elektronik seperti Handphone atau telephone genggam yang
memiliki banyak fungsi yang dapat mempermudah pekerjaan
manusia sehari- hari yang biasa disebut smartphone yang semakin
hari semakin berkembang. Dalam penggunaan smartphone untuk
kalangan anak-anak sekolah dasar sekarang sudah semakin
banyak, dikarenakan sejak kecil orang tua mereka sudah
membiasakan anak mereka menggunakan smartphone dengan
platform android. Pada saat ini aplikasi yang banyak beredar
didominasi oleh aplikasi yang diperuntukkan kepada orang
dewasa, sedangkan aplikasi yang bermanfaat dan ditujukan
khusus untuk sekolah dasar masih tergolong sedikit, dan materi
edukasinya masih terbatas. Dengan memanfaatkan banyaknya
pengguna yang menggunakan platform android saat ini di
kalangan anak — anak sekolah dasar , maka dilakukan penelitian
guna bertujuan untuk mencoba membuat aplikasi yang bisa
mempermudah anak — anak dalam belajar tentang system syaraf
mata pada manusia dalam hal ini pembuatan aplikasi
pembelajaran interaktif. Metode penelitian yang digunakan adalah
Multimedia Development Life Cycle (MDLC) yang memiliki enam
tahapan yaitu concept (Konsep), design (desain), material collecting
(pengumpulan materi), assembly (pembuatan), testing (pengujian)
dan distribution (distribusi).

Kata kunci — Mata; Aplikasi Pembelajaran; Sekolah Dasar;
Android; Multimedia Development Cycle;

I.  PENDAHULUAN

Dalam pembelajaran disekolah dasar terdapat beberapa mata
pelajaran yang diajarkan , salah satunya mata pelajaran biologi
yang didalamnya terdapat pelajaran mengenai system syaraf,
contohnya system syaraf mata pada manusia , pentingnya materi
itu agar para anak — anak sekolah dasar bisa memahami lebih

dalam tentang system saraf mata. Kegiatan belajar di dalam kelas
dengan lisan, tulisan bahkan slide powerpoint dapat menyebabkan
pembelajaran menjadi kurang menarik dan cenderung
membosankan.[1]

Dengan penggunaan media dapat meningkatkan prestasi dan
motivasi belajar siswa. Dengan adanya media pembelajaran
akan membuat proses pembelajaran lebih menarik, misalnya dari
segi tampilan yang dikombinasikan dengan beberapa gambar
ataupun animasi. [2]

Dalam tahap ini, siswa akan lebih mudah mengingat suatu
bentuk atau tulisan yang memiliki ciri warna menarik dan betuk
komunikatif dan menyenangkan.[3]

Keindahan, kemenarikan dan adanya interaktivitas dalam
suatu media pembelajaran merupakan sarana agar peserta
didik tidak jenuh dalam mengikuti pelajaran dan efek yang
terbesar diharapkan peserta didik dapat termotivasi dan
mempermudah dalam menerima materi pelajaran. [4]

Sesuai dengan permasalahan diatas maka, penelitian ini
bertujuan mengembangkan aplikasi pembelajaran interaktif
sebagai media pembelajaran Sekolah Dasar agar anak-anak lebih
mudah dalam belajar dan memahami materi tentang mata dan
fungsinya. Penelitian ini diharapkan dapat menambah wawasan
dan meningkatkan pemahaman tentang struktur dan sistem kerja
dalam pengembangan aplikasi pada sistem operasi Android serta
mempermudah anak-anak agar dapat mempelajari tentang system
syaraf mata dengan melihat gambar dan mendengan
penjelasannya.

A. Pengertian Mata

Mata adalah salah satu panca indra yang sangat penting, yaitu
untuk berinteraksi dengan lingkungan sekitar.[5]

Mata merupakan alat indra yang terdapat pada manusia yang
secara konstan menyesuaikan pada jumlah cahaya yang masuk,
memusatkan perhatian pada objek yang dekat dan jauh serta
menghasilkan gambaran yang kontinu yang dengan segera di
hantarkan pada otak. Penglihatan pada manusia melibatkan
deteksi gelombang cahaya yang sangat sempit dengan panjang
gelombang sekitar 400 sampai 750 nm. Mata memiliki
fotoreseptor yang mampu mendeteksi cahaya. Setiap mata
mengandung sekitar 126 juta fotoreseptor ( 120 juta reseptor
batang dan 6 juta reseptor konus) dan hanya 1,5 juta sel ganglion.
Ini berarti bahwa terdapat sejumlah besar konvergensi dari
reseptor dan sel bipolar menjadi sel ganglion, tetapi hal ini tidak
terjadi secara seragam di kedua sisi retina.

B. Anatomi Sistem Reseptor Mata

Anatomi berarti mengurai atau memotong. ilmu bentuk dan
susunan tubuh dapat diperoleh dengan cara mengurai badan
melalui potongan bagian-bagian dari badan dan hubungan alat



tubuh satu dengan yang lain. Pengetahuan tentang anatomi dan
fisiologi tubuh merupakan dasar yang penting dalam
melaksanakan asuhan keperawatan.

Sistem kerja reseptor visual cahaya masuk kedalam melalui
pupil (merupakan lubang pada iris), besar-kecilnya ukuran pupil
saat menangkap perubahan suatu cahaya ditentukan oleh dua
level yaitu dari sensitivitas (kemampuan untuk mendeteksi
keberadaan suatu objek dalam keadaan cahaya yang
minim/remang-remang) dan ketajaman (kemampuan untuk
melihat suatu objek secara detail).

Reseptor pada mata terletak di retina mempunyai lapisan-
lapisan sebagai berikut yaitu, dua reseptor rod dan cone,
horizontal cells, bipolar cells, amacrine cells dan retinal
ganglion cells (Gambar 1 di bawah untuk penjelasan struktur
retina).

Choroid

Cornea

Pupil

Optic nerve

Ciliary body

Gambar 1. Struktur Retina
C. Anatomi Sistem Penglihatan

Menurut ilmu anatomi mata manusia terbagi menjadi dua bagian
yaitu :
1. Bagian Luar
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centhus
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Gambar 2. Bagian Luar Mata

a) Bulu Mata
Bulu mata yaitu rambut-rambut halus yang terdapat dditepi
kelopak mata.

b) Alis Mata
Alis yaitu rambut-rambut halus yang terdapat diatas mata.

¢) Kelopak Mata
Kelompak mata merupakan 2 buah lipatan atas dan bawah kulit
yang terletak di depan bulbus okuli.

d) Kelenjar Air Mata
Kelenjar yaitu tempat keluar nya air mata.
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Gambar 3.Bagian Dala;n Mata

a. Konjungtiva
Kongjungtiva adalah membrane tipis bening yang melapisi
permukaan bagian dalam kelopak mata dna menutupi bagian
depan sklera (bagian putih mata).

b. Sklera
Sklera merupakan selaput jaringan ikat yang kuat dan berada pada
lapisan terluar mata yang berwarna putih.

c. Kornea
Kornea merupakan selaput yang tembus cahaya, melalui kornea
kita dapat melihat membran pupil dan iris.

d. Koroid
Koroid adalah selaput tipis dan lembab merupakan bagian
belakang tunika vaskulosa (lapisan tengah dan sangat peka oleh
rangsangan).

e. lris
Iris merupakan diafragma yang terletak diantara kornea dan mata.

f.  Pupill
Pupil menentukan kuantitas cahaya yang masuk ke bagian mata
yang lebih dalam.

0. Lensa
Lensa adalah organ focus utama, yang membiaskan berkas-berkas
cahaya yang terpantul dari benda-benda yang dilihat, menjadi
bayangan yang jelas pada retina.

h. Retina
Retina merupakan lapisan bagian dalam yang sangat halus dan
sangat sensitif terhadap cahaya. Pada retina terdapat

reseptor(fotoreseptor).

i. Aqueous humor
Agquaeous humor atau cairan berair terdapat dibalik kornea yang
mengandung nutrisi bagi kornea dan dapat melakukan difusi gas
dengan udara luar melalui kornea.

j. Vitreus humor (Badan Bening)
Badan bening ini terletak dibelakang lensa. Bentuknya berupa zat
transparan seperti jeli(agar-agar) yang jernih. Zat ini mengisi pada
mata dan membuat bola mata membulat.

k. Bintik Kuning
Bintik kuning adalah bagian retina yang paling peka terhadap
cahaya karena merupakan tempat perkumpulan sel-sel saraf yang
berbentuk kerucut dan batang.

D. Fisiologis penglihatan

Tujuan ilmu fisiologi untuk menjelaskan factor-faktor fisika dan
kimia yang bertanggung jawab terhadap asal - usul perkembangan
dan kemajuan kehidupan virus/bakteri yang paling sederhana
sampai yang paling rumit dan mempunyai Kkarakteristik
fungsional tersendiri. Fisiologi manusia berhubungan dengan sifat
spesifik dan mekanis tubuh manusia yang membuat manusia
sebagai mahluk hidup yang bias mengindra, merasa, dan mengerti
segala sesuatu selama dalam rangkaian kehidupan.
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E. Sistem Saraf

Sistem atau susunan saraf merupakan salah satu bagian
terkecil dari organ dalam tubuh, tetapi merupakan bagian yang
paling kompleks. Materi sistem saraf manusia merupakan

salah satu materi penting untuk dapat memahami
konsep-konsep selanjutnya terutama dalam fisiologi
manusia.[6]
F. Interaktif

Interaktif memiliki makna yaitu secara aktif saling
memberikan respon dari aksi-aksi yang dilakukan antara
pengirim aksi dan penerima aksi.

Klasifikasi interaktif dalam lingkup multimedia pembelajaran
bukan terletak pada sistemhardware, tetapi lebih mengacu pada
karakteristik belajar siswa dalam merespon stimulus yang
ditampilkan layar monitor komputer. Kualitas interaksi siswa
dengan komputer sangat ditentukan oleh kecanggihan program
komputer.[7]

G. Aplikasi pembelajaran Interaktif

Aplikasi adalah program yang dibuat dalam sebuah perangkat
lunak dengan komputer untuk memudahkan pekerjaan atau
tugas-tugas seperti penerapan, penggunaan, dan penambahan
data yang dibutuhkan.[8]

Aplikasi pembelajaran interaktif merupakan program yang
berfungsi sebagai alat atau bahan yang dipergunakan dalam
kegiatan belajar, apalagi dengan menggunakan media interaktif
yang bisa menarik minat user untuk belajar serta bisa
mempermudah user dalam mempelajari materi yang diajarkan.

Mutu pembelajaran ini sangat dtentukan dari kecanggihan
aplikasi pembelajaran interaktif yang di gunakan.[9]

H. Multimedia Development Life Cycle (MDLC)

Pengembangan media pembelajaran interaktif
membutuhkan metode pengembangan perangkat lunak, salah
satu metode pengembangan yang dapat digunakan adalah
metode Multimedia Development Life Cycle(MDLC).[4]

Menurut Luther (1994), model pengembangan multimedia
terdiri dari enam tahapan, yaitu concept, testing, material
collecting, assembly, testing and distribution.

Il. METODE
A.  Kerangka Pikir

Identifikasi

Pengembanga
n Aplikasi

Pengumpulan Evaluasi Distribusi Kesimpulan
Data

Masalah

Gambar 4. Kerangka Pikir

Masalah penelitian didapatkan dari studi literatur dan
pengamatan berbagai media yang telah ada untuk mencari
kekurangan dari media tersebut hingga didapatlah masalah yang
ada kemudian dibuatlah penelitian ini. Dengan menggunakan
teknik pengumpulan data yang mencari berbagai literatur yang

dibutuhkan dalam mendukung ide pada pembuatan sistem yang di
ambil dari berbagai sumber seperti buku, paper dan jurnal yang
terkait. Pengembangan aplikasi dilakukan dengan menggunakan
metode Multimedia Development Life Cycle yang mempunyai
enam tahapan vyaitu Concept, Design, material Collecting,
Assembly, Testing and Distribution. Distribusi tahap dimana
aplikasi disimpan dalam suatu media penyimpanan. Aplikasi
pembelajaran interaktif tata cara wudhu ini dibuat dengan
menggunakan Blender dan Unity dan di build dalam bentuk file
.apk (Application Package File) agar dapat dengan mudah
dijalankan pada perangkat android.

B. Waktu dan Tempat penelitian

Penelitian ini dilaksanakan dari bulan Februari 2021 sampai
dengan bulan Mei 2021. Proses penelitian dilakukan di Lab
Rekayasa Perangkat Lunak, sedangkan untuk pengujian dilakukan
kepada siswa siswi sd yang berada dikelurahan malalayang dua
lingkungan 6 perumahan lingkungan 6 kepada siswa siswi
sekolah dasar yang berada dirumah.

C. Analisa Kebutuhan Sistem

Spesifikasi perangkat keras yang digunakan dalam
pengembangan Aplikasi Pembelajaran Interaktif Sistem Syaraf
Mata Manusia untuk Sekolah Dasar yaitu laptop ASUS X454Y]
dengan spesifikasi AMD A8-7410 APU Quad Core up to 2,5GHz,
RAM 6 GB dan menggunakan sistem operasi Windows 10 64 bit
Sedangkan perangkat lunak yaitu Photosop CS6, Adobe Audition
CC 2020, Blender Versi 2.79, Unity Versi 2018.4.3, dan
Wondershare Fimore

D. Metode Penelitian

Metode penelitian yang digunakan adalah Multimedia
Development Life Cycle (MDLC) yang memiliki enam tahapan
yaitu concept (Konsep), design (desain), material collecting
(pengumpulan materi), assembly (pembuatan), testing (pengujian)
dan distribution (distribusi). Diagram proses MDLC terlihat pada
gambar 5.

Gambar 5. Diagram proses MDLC

1.Concept (Konsep)

Pada tahap ini untuk menentukan tujuan pembelajaran,
menentukan konsep materi dan menentukan konsep media
pembelajaran.

Ada beberapa tahapan,antara lain :

1) Menggunakan animasi tiga dimensi untuk menarik minat
anak-anak.

Media pembelajaran system syaraf mata oleh anak-anak
usia 6-12 tahun.

Aplikasi ini berjalan di sistem operasi android.

Konten yang dibuat berupa pengajaran apa itu mata,
bagian — bagian mata, bagian luar mata, bagian dalam
mata, cara kerja mata.

2)

3)
4)



5) Interaktif pada aplikasi ini terletak pada tombol yang
dapat dioperasikan oleh user. Aplikasi ini memiliki
menu yang berisi pertanyaan yang membuat user dapat
memilih jawaban dari pertanyaan yang ada dan aplikasi
yang dibuat disertai dengan audio.

2.Design (Perancangan)

Pada tahap ini untuk menganalisis seluruh kegiatan dalam
arsitektur yang ada pada sistem secara keseluruhan. Serta,
menentukan arsitektur, gaya, tampilan dan material yang akan
digunakan pada perangkat yang akan dibuat. Sistem yang
akan dikembangkan dengan menggunakan model use case
diagram dan activity diagram.

a. Use Case

ser

< A
/M(»Imu('ldmpilaﬂ Awal
C J—
S,

Gambar 6. Use Case Diagram Aplikasi

Nama Use
Case

Aktor
Deskripsi

Precondition

Normal Course

Alternate
Course
Post-condition

Nama Use Case
Aktor

Deskripsi
Precondition

Normal Course

Tabel 1. Use Case Tampilan Awal
Melihat Halaman Awal

User (Pengguna)

Proses melihat tampilan awal aplikasi
Pengguna harus memiliki aplikasi Belajar
Mata

Kegiatan Aktor Respon
Sistem

Pengguna membuka = Menampilkan

aplikasi halaman awal

User bisa melihat tampilan awal aplikasi
yang sebagai tombol untuk bisa ke menu
selanjutnya

Tabel 2. Use Case Menu Materi

Materi

User (Pengguna)

Proses dimana user melihat materi
aplikasi

Sistem menyediakan tombol untuk
membuka menu materi

Alternate
Course
Post-condition

Nama Use Case
Aktor
Deskripsi

Precondition

Normal Course

Alternate
Course
Post-condition

Nama Use
Case
Aktor
Deskripsi

Precondition
Normal
Course

Alternate
Course
Post-
condition

Nama Use Case
Aktor
Deskripsi

Precondition

Normal Course

Alternate
Course
Post-condition
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dalam mata

User bisa membuka materi dan keluar
dari aplikasi

Tabel 3. Use Case Menu Quiz

Melihat Menu Quiz

User (Pengguna)

Proses dimana user dapat melihat Menu
Quiz

Sistem menyediakan tombol untuk
masuk ke Quiz

Kegiatan Aktor

Respon Sistem

Memilih tombol Menampilkan
pilihan jawaban soal berikutnya
Memilih tombol Kembali ke
kembali menu utama

User bisa memilih jawaban quiz dan
keluar kembali ke menu utama

Tabel 4. Use Case Menu Tetang
Tentang

User (Pengguna)
Pengguna memasuki halaman tentang
yang berisikan tujuan aplikasi ini dibuat
Tampilan Main Menu
Kegiatan Aktor
Menekan tombol
tentang

Respon Sistem
Menampilkan
informasi
tentang aplikasi

User dapat melihat informasi tentang
aplikasi serta tombol main menu untuk
kembali ke Main Menu

Tabel 5. Use Case Keluar
Keluar
User (Pengguna)
Proses dimana user dapat keluar dari
aplikasi belajar mata
Sistem menyediakan tombol
keluar untuk keluar dari aplikasi
Kegiatan Aktor Respon Sistem

untuk

1. Menekantombol 1. Aplikasi
keluar akan

otomatis

berhenti

User keluar dari aplikasi

b. Activity Diagram

Kegiatan Aktor
Menyentuh layar

Respon Sistem
Menampilkan
menu bagian luar
mata dan bagian

Activity diagram merupakan gambaran proses berjalannya setiap
urutan aktivitas dalam sebuah proses agar lebih mudah untuk
dimengerti.

e Activity Diagram menampilkan Main Menu
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Gambar 7. Activity Diagram Main Menu
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Gambar 8. Activity Diagram Materi

e  Activity Diagram Menampilkan Quiz
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Gambar 9. Activity Diagram Quiz

e Activity Diagram Menampilkan Menu Tentang

User g Aplikasi

Menampilkan
tampilkan awal

Membuka aplikasi

Melihat interface >

<

menu awal

(=)
menu tentang

@+

Gambar 10. Activity Diagram Tentang

3.Material Collecting(Pengumpulan Material)

Dalam tahap ini proses pengumpulan data yang dilakukan
dengan studi literatur yang digunakan sebagai referensi dalam
proses penelitian untuk aplikasi pembelajaran interaktif tata cara
wudhu yang kemudian dijadikan obyek dari penelitian ini.

4.Assembly(Pembuatan)

Tahap ini merupakan tahap dimana seluruh objek atau bahan
multimedia dibuat. Semua objek dan material dibuat dan
digabungkan sehingga menjadi satu aplikasi yang utuh.

5.Testing(Pengujian)

Tahap pengujian dilakukan setelah menyelesaikan tahap
pembuatan dengan menjalankan aplikasi dan melihat apakah ada
error atau kesalahan dalam aplikasi yang dibuat. Yang pertama
adalah pengujian alpha (alpha test) yaitu pengujian yang
dilakukan oleh pembuat atau lingkungan pembuatnya sendiri.
Dengan melakukan testing terhadap seluruh fungsi aplikasi.
Yang kedua adalah pengujian beta (beta test) yaitu melakukan
pengujian Kkuisioner tentang penilaian media pembelajaran
dengan responden siswa Sekolah Dasar.

6.Distribution(Distribusi)

Pada tahapan ini aplikasi pembelajaran dapat di distribusikan
ke toko online android.

Proses yang dilakukan dalam tahap produksi adalah
menyimpan media pembelajaran ke media penyimpanan yang
berupa Compact Disk (CD), kemudian didistribusikan ke guru
yang ada di sekolah tersebut untuk digunakan sebagai alat bantu
mengajar dalam proses pembelajaran pengenalan abjad dan
angka.[10]

[1l. HASIL DAN PEMBAHASAN
A.Assembly (Pembuatan)

Berdasarkan dari desain yang telah dibuat, dilanjutkan pada
tahap pengembangan sistem dengan langkah pembuatan objek
berupa mata yang dibuat dengan menggunakan Blender serta
digunakan dalam pembuatan animasi. Dan pembuatan aplikasi
interaktif dengan menggunakan Unity.



1) Pembuatan Aplikasi
Berikut adalah Tampilan awal unity pada gambar 10

Gambar 10. Tampilan awal Unity

1. Membuat beberapa folder dengan cara klik kanan pada
> Folder, seperti pada gambar 11.

e - x s

|

e
L

Hamptl

Lesocy

Gambar 11.Create Folder

2. Mulai dengan membuat Scene baru dengan cara klik
kanan > Create > Scene, kemudian beri nama Opening
Scene.

At
A prerans

&
i
s
o
o
.
e

Eambg; 12. Creéte Scene Opening

3. Import assest yang berupa gambar yang akan
digunakan dalam pembuatan aplikasi dengan cara klik kanan
> Import New Assets. Lalu tambahkan komponen canvas
dengan cara klik kanan pada Hierarchy > Ul > Canvas.
Tambahkan tombol dengan cara klik kanan pada Hierarchy >
Ul > Button, kemudian beri nama Background. Hapus Text
pada Button lalu sesuaikan ukuran tombol dengan canvas,
pada bagian Source image lakukan drag and drop aset gambar
yang akan dijadikan latar.

Billy Pascal Lantiunga — Aplikasi

Gambar 13.Scene Opening

4. Buat script pindahscene dengan cara klik kanan pada
Project > C# Script. Script seperti pada gambar 14.

using
2 using
3 using UnityEngine;

4 using UnityEngine.SceneManag
5

public class

8 public void 0

11 }
12 )

Gambar 14.Script pindah Scene

5. Memasukan Script pindahscene pada PlayButton yang
ada di Hierarchy dengan cara drag and drop. Selanjutnya klik
PlayButton lalu drag and drop PlayButton pada bagian On
Click (') pada inspector lalu pilih fungsi NextLevel > NextScene
(string), Seperti pada Gambar 15.

Gambar 15 Mengatur Pindah Scene

6. Membuat Scene baru dan beri nama MenuScene.
Tambahkan 5 tombol dengan cara klik kanan pada Hierarchy >
Ul > Button. Hapus text yang ada pada button selanjutnya ubah
nama button menjadi MateriButton, QuizButton,
TentangButton, SoundButton, ExitButton. Ubah gambar pada
button dengan cara klik pada salah satu button kemudian pada
bagian Source image lakukan drag and drop aset gambar yang
akan dijadikan latar selanjutnya sesuaikan ukuran dari button,
tambahkan objek Text dengan cara klik kanan pada Hierarchy
> Ul > Text, kemudian pada inspector ubah Text “Materi, Quiz,
Tentang”.seperti gambar 16.

Gambar 16. Menu Scene
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7. Tambahkan sourcecode baru dengan nama exit. Script
seperti pada gambar 18.

public void Q)
r
{

1
7

Gambar 17.Script Exit

8. Klik ExitButton lalu drag and drop ExitButton ke
baglan On Click () pada inspector lalu pilih fungsi exit >

Gambar 18. Mengatur ExitButton

9. Membuat Scene baru dan beri nama MateriScene.
Tambahkan 1 tombol dengan cara klik kanan pada Hierarchy
> Ul > Button. Hapus text yang ada pada button selanjutnya
ubah nama button menjadi NextButton. Ubah gambar pada
button dengan cara klik button kemudian pada bagian Source
image lakukan drag and drop aset gambar yang akan
dijadikan latar selanjutnya sesuaikan ukuran dari button. Buat
canvas dengan cara klik kanan pada Hierarchy > Ul >
Canvas, Tambahkan objek Text dengan cara klik kanan pada
Hierarchy > Ul > Text, kemudian pada inspector ubah Text
“Apa Itu Mata ?”, lalu tambakan lagi text kemudian pada
inspector ubah Text lalu masukan pengertian mata. Lalu buat
Panel dengan cara klik kanan pada Hierarchy > Ul > Panel,
Kemudian pada inspector tambahkan Videoplayer dengan
cara klik pada Add Component lalu pada kolom Search
ketikkan Videoplayer lalu enter, lalu tambahkan AudioSource
dengan cara klik pada Add Component lalu pada kolom
Search ketikkan Audio Source lalu enter, tambahkan Raw
Image dengan cara klik pada Add Component lalu pada kolom
Search ketikkan Raw Image lalu enter. Kemudian pada bagian
Project Tambahkan VideoTexture dengan cara klik kanan
pada Project create > Render Texture lalu ganti nama menjadi
Video Texture, pada bagian video clip lakukan drag and drop
aset video yang akan diputar, pada bagian Target Texture dan
Texture Iakukan drag and drop aset Video Texture yang telah

m*lmllm ? :
MATA MEKIIPIIMN ALAT

UMUK MELHAT, ‘CONTOH
MATA ADA PADA GAMBAR
NG -

Gambar 19. Materi Scene

10. Buat canvas baru. Tambahkan 3 tombol dengan cara klik
kanan pada Hierarchy > Ul > Button. Hapus text yang ada
pada button selanjutnya ubah nama button menjadi
BagianDalamMata, BagianLuarMata, BackButton. Ubah
gambar pada button dengan cara klik button kemudian pada
bagian Source image lakukan drag and drop aset gambar yang
akan dijadikan latar selanjutnya sesuaikan ukuran dari button.
Seperti Gambar 20

Gambar 20.Materi bagian-bagian mata scene

11.  Buat canvas baru yang berisi penjelasan tentang bagian —

bagian mata dengan cara kita buat canvas baru lalu buat button

bagian mata dalam dan bagian luar mata,tambahkan juga button
bar 21 dan 22.

Gambar 22.Bagian Mata Dalam
12. Membuat canvas yang berisi pengertian dan fungsi dari
bagian — bagian mata.Tambahkan 2 tombol dengan cara klik
kanan pada Hierarchy > Ul > Button. Hapus text yang ada
pada button selanjutnya ubah nama button menjadi NextButton,
BackButton. Contohnya seperti pada gambar 22.



Gambar 22.Pengertian dan fungsi Mata

13. Menambahkan audio untuk penjelasan mengenai bulu
mata dengan cara klik kanan pada Hierarchy > Audio >
AudioSource . Klik objek Bulu Mata kemudian pada bagian
Audio Clip lakukan drag and drop aset sound yang akan
gijadikan penjelasan materi bulu mata. Seperti gambar 23.
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Berikut isi dari script pada gambar 25.

bstng
using
ustng
using

public class
public

void

public votd boot
if

false

false

true);

folse);
true

void

Gambar 25. Script Jawab

16. Masukan script skor pada label dengan cara drag and
drop, klik pada pilihan jawaban yang benar (A,B,C,D) lalu
pada bagian On Click () di inspector drag and drop soal klik no
function > jawab > jawaban (bool) lalu Klik centang. Seperti
gambar 26.

Bagian Mata Luar terdiri atas
berapa bagian ?

Gambar 23. Memasukan Audio Materi

14. Membuat scene baru yang berupa Quiz Scene.
Merupakan scene yang berisi 10 pertanyaan tentang mata
yang jika menjawab benar akan mendapatkan nilai 10
sedangkan jika menjawab salah tidak akan ada tambahan nilai.
Tambahkan panel dengan cara klik kanan > Ul > Panel, dan
beri nama Panel Soal, panel yang nantinya akan menampilkan
pertanyaan dari soal yang akan diinput. Tambahkan text di
dalam panel dengan cara klik kanan > Ul > Text. Dalam panel
pertanyaan tambahkan panel soal yang berisi 4 tombol dengan
nama A, B, C, D yang akan menjadi tombol pilihan jawaban.
Selanjutnya buat Panel Label yang berisi Text yang
bertulisakan nilai dan angka yang nantinya berfungsi untuk
menampilkan nilai dari jawaban yang benar. Buat lagi panel
baru dengan nama panel feedback yang berisi animasi gambar
yang akan menunjukan animasi berbeda jika jawaban yang
dipilih benar atau salah. Hasilnya seperti gambar 24.

Bagian Mata Luar terdiri atas
berapa bagian ?
~—03

Gambar 24. Quiz Scene

15.  Membuat script baru dengan cara klik kanan pada
Project > Create > C# Script, ubah nama menjadi jawaban.

cming

Gambar 26 Inspector Jawab

17.  Setelah semua scene dibuat langkah selanjutnya adalah
membangun (build) aplikasi. Dengan cara klik menu File >
Build Setting. Tampilan build setting ada pada gambar 27.

,f E3E) x”|§|" v:‘ % nl T =Y. ..,.'l - — o ‘.

Gambar 27. Build Setting

18.  Selanjutnya masukan semua scene yang telah dibuat tadi
di Scenes In Build. Dan pilih platform Android. Setelah itu klik
tombol Build. Pilih tempat file akan tersimpan yaitu di Desktop
dan ubah nama file menjadi Belajar Mata, file akan tersimpan
dengan format .apk. Seperti gambar 28.
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Gambar 32. Tampilan Pilihan Materi

Gambar 28.Build Aplikasi

B.Testing(Pengujian)
Pengujian ini bermaksud untuk mengetahui apakah aplikasi
sudah berjalan dengan baik atau tidak. Jika sudah tidak ada
masalah atau error pada aplikasi, maka dilakukan pengujian
terhadap pengguna.
1. Alpha Test
Berikut adalah hasil testing aplikasi setelah aplikasi di
build dan di install pada platform android, dapat dijalankan
dengan tampilan landscape left.
1) Tampilan Pembuka

Gambar 29. Tampilan Pembuka

2) Tampilan Menu ~ Bagian Mata Luar terdiri atas
. berapa bagian ?

Gambar 35. Tampilan Quiz

- Dari hasil testing ini menunjukan aplikasi sudah dapat dijalankan
Gambar 30, Tampilan Menu dengan baik dan tombol-tomol dalam aplikasi juga berfungsi

dengan baik, lebih jelasnya hasil testing ada pada tabel 6 sampai
dengan tabel 9.

3) Tampilan Materi
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IV. KESIMPULAN DAN SARAN
A. Kesimpulan

Berdasarkan hasil penelitian yang dilakukan dengan
menggunakan  metode  Multimedia  Development  Life
Cycle(MDLC), maka penulis berhasil membuat aplikasi
pembelajaran interaktif materi system syaraf mata. Keseluruhan
dari aplikasi pembeajaran terdiri dari teks, gambar, animasi dan
suara, sehingga sangat menarik dan interaktif untuk
digunakan sebagai media pembelajaran di sekolah dasar.
Aplikasi pembelajaran berbasis android ini telah dilakukan tahap
validasi ahli, yaitu ahli media, ahli desain, dan ahli materi yang
memperoleh kriteria kelayakan “baik”. Kemudian uji coba yang
dilakukan pada siswa dengan skala perorangan memperoleh
kriteria kelayakan “baik”.

Jadi dapat disimpulkan bahwa media pembelajaran berbasis
android ini memiliki tingkat kelayakan dan kemenarikan produk
pada kriteria baik dan responden juga memberikan tanggapan
bahwa responden lebih tertarik belajar dan mudah memahami
materi dengan penggunaan aplikasi media pembelajaran
interaktif system syaraf mata yang dapat diakses lewat
smartphone masing-masing murid. Sehingga dapat dikatakan
layak untuk diterapkan di sekolah.

B. Saran

Beberapa saran dibuat untuk pengembangan lebih lanjut:

1) Diharapkan dapat mengembangkan Aplikasi
Pembelajaran interaktif lebih lanjut baik dari segi keluasan,
kedalaman dan keterkinian materinya sesuai dengan kurikulum
yang berlaku sehingga menjadi salah satu sumber belajar yang
baik untuk peserta didik. Serta, dapat dijalankan dalam platform

lainnya.

2) Aplikasi  Pembelajaran  interaktif ~ ini  dapat
didesiminasikan yaitu melalui kerja sama dengan dinas
pendidikan dan melalui berbagai forum lainnya sehingga

multimedia interaktif yang dikembangkan ini dapat digunakan
oleh seluruh SD/MI, khususnya untuk pembelajaran System
Syaraf Mata dalam hal meningkatkan hasil belajar peserta didik.
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